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Note 
This Instruction explains the correct usage of the device and serves 
prevention of danger. All persons who apply or use, care of, maintain 
and control the device have to read and follow it. It is part of the device 
and should always be at the user’s disposal. 
 
 
 
 
 
 
 
 
 
 
 

* * * 
 
 
 
 
 
 
 
 
 
 
 

Copyright notice 
Copyright © by HOLOEYE Photonics AG. All rights reserved. Under 
the copyright laws, this manual cannot be reproduced without prior 

written permission by HOLOEYE. 
 
 

Technical specifications given in this document are subject to 
change without notification. 
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SLM Pattern Generator 
1 HOLOEYE SLM Pattern Generator Software 

The HOLOEYE SLM Pattern Generator 
software allows the computation of 
computer generated holograms (CGH’s) 
from user defined signals as well as the 
generation of elementary optical functions 
such as different kind of gratings etc. as 
well as the superposition of different 
CGH’s. The generated CGH’s can be 
displayed on the SLM within the software 
and can be modified by a superposition 
of holographic functions on the fly. 
 

1.1 Installation 

1.1.1 Microsoft® Windows® 

In order to make a successful installation, you should make sure that 
you have sufficient privileges in the computer’s operating system 
(Microsoft Windows™ 7  or higher). You should be permitted to create 
a directory in the directory that contains programs and copy files into 
that directory, and to write into the ‘all users’ section of the start menu 
of your operating system. Of course administrator privileges will be 
sufficient for all these operations.  
Start the executable file ‘HOLOEYE SLM Pattern Generator 3.3 (64|32 
bit).exe’ for 32- or 64-bit OS and follow the instructions of the 
installation menu.  
Please accept the license agreement before selecting the program 
components to install. In order to install the complete version, mark all 
checkboxes. Choose the destination folder as well as the start menu 
folder. Select ‘Install’ to start the installation procedure and finally 
‘Close’ to finish the installation. 

1.1.2 Mac OS X 

• This software needs Mac OS X 10.7 or higher 
• Open by double click on “HOLOEYE SLM Pattern Generator 

3.3.dmg” the image file 

Figure 1: Screenshot of SLM 
Pattern Generator Software 
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• Shift the Holoeye Application into App Folder 

 
Figure 2: Install dialog on MacOS X 

 

• When running the software for the first time, a warning concerning 
‘unknown external software’ may be displayed. Click ‘open’ for 
confirmation. 

• To prevent the display of the top-bar on the SLM the option 
“Displays have separate Spaces” needs to be disabled in the 
System Preferences -> Mission Control Settings. (see Figure 3) 

 

 
Figure 3: Mission Control Settings 

 

1.1.3 Ubuntu 

This software was designed for Ubuntu 14.04 LTS or higher. 
Please install the package by typing 
 
cd path_to_installer_file/ 

sudo dpkg –i “HOLOEYE SLM Pattern Generator 3.3.deb”  

sudo apt-get install –f 
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in “Terminal” or open it with “Software Center” by double click and 
press the “install” button. 
The second command in “Terminal” is only needed if some remaining 
dependencies could not been resolved in the installation step. 
 

1.2 Starting the software 

Before starting the Software it is recommended to connect the SLM 
and set it up as an extended Desktop Monitor. (This mode is so called 
in Microsoft Windows OS. When using other operating systems, the 
name of this mode may called different). In this mode the software is 
able to address a full-size output to the SLM. (See comments in 1.2.2 
SLM full-screen support within extended desktop). 
 

1.2.1 SLM device detection 

Start the program using the icon  of the software which was created 
during the installation process.  
Upon start-up, the SLM device will be detected. A dialog will open 
which shows the available SLMs. If only one was detected, the dialog 
will disappear automatically after a short time and the software starts 
(see Figure 4). If the device could not be detected clearly, there is the 
option to configure the screen configuration. The options appear in a 
menu after clicking the “Configure” button (see Figure 5). There are 
options to either solve the problem automatically or to open the 
operating systems screen configuration dialog and correct the 
problems manually. 
 

 
Figure 4: Device detection dialog 

continues automatically if SLM was clearly detected. 

 
If multiple devices are found, each device can be identified by 
hovering the mouse cursor above the device image. A hint will show 
up after a short time and will show details about the SLM, including the 
current position on the desktop. 
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Figure 5: Device detection dialog in case the SLM is not properly configured. 

 
The device selection dialog prevents the usage of the following screen 
configurations: 
- Wrong SLM resolution 
- Wrong SLM refresh rate 

 
The selected SLM device can later be seen in the “About Device” 
menu inside the “Help” sub-menu. 

1.2.2 SLM full-screen support within extended desktop 

With more than one screen the program will display the content of full-
screen windows to the SLM with the correct resolution, and in addition 
open a monitor window on the GUI screen for convenient supervision 
of what is being displayed.  
The most straightforward option is of course operating the SLM as an 
external monitor by setting the graphics adapter settings of the 
operating system to a ‘Display clone mode’. However, there are a few 
disadvantages of the ‘Display clone mode’ which make using an 
‘Extended desktop’ configuration attractive. 
Firstly, the full-screen window has a boundary (and potentially a button 
toolbar) which somewhat reduces the area of the SLM usable as an 
optical element. Secondly, the operation in ‘clone mode’ is easy only if 
the primary display and the SLM are operated at the same pixel 
resolution, which may not be desirable. Third, if the PC or Laptop that 
controls the SLM should be used for other tasks in parallel, the 
‘extended desktop mode’ permits to do so without interacting with the 
operation of the SLM. 
The use of the software with the ‘extended desktop mode’ can be 
tested most conveniently with the SLM in amplitude modulation (using 
a suitable polarizer configuration) – or with an additional computer 
display operated at the SLM’s pixel resolution in mirror mode. 
Under Microsoft Windows, the screen magnifier in “docked” mode can 
also be used to inspect the content on the SLM easily. Another option 
is to make a screenshot of all displays by pressing the “Print” key on 
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the keyboard of the PC and pasting the content to e. g. Microsoft 
Paint. 
 

1.2.3 Operating-System power saving features 

As soon as there is content on the SLM, the software tells the 
operating system not to start any power saving features, including 
locking of the screen. This means, all automatic functions which would 
interrupt the SLM content display are disabled.  
 
Please note that if automatic screen locking e. g. is switched on for a 
good reason on the user’s PC, it will be disabled as long as there is an 
open window on the SLM. If you want to have a screen lock while 
displaying content on the SLM, please lock the screen manually. Also, 
energy saving features can be used manually while there is content 
displayed on the SLM. 
 

1.2.4 Selection of optical parameters 

At each start of the software, the dialog of the optical parameters is 
shown to make sure they are correctly set before using any functions 
inside the software (See Figure 6). Many functions depend on the 
wavelength of the incident light to the SLM. So please enter the 
wavelength used in the optical setup.  
There is also the option to select the desired Zernike radius. The 
default Zernike radius (behaviour of versions prior to 3.3 of this 
software) is to use the height of the SLM to make sure the full Zernike 
area is on the SLM. There are two more predefined Zernike radius 
options, but every value from 0,001 mm to the diagonal of the SLM 
(full SLM is in Zernike area) is allowed. 
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Figure 6: Optical parameters dialog 

 
The optical parameters can later be accessed via the main menu 
under Preferences -> Optical Parameters. If any function is opened, 
then the values will not be editable. In such a case, if you like to 
change the values, please follow all instructions from the upcoming 
messages. The optical parameters are saved before closing and 
reopening the software. 

1.3 The image window 

1.3.1 Opening an image file 

Choose from the File menu the point ’Open Image File’. The 
supported image formats are BMP, PNG, JPEG, GIF, XBM, XPM, 
MNG and the different PNM formats: PBM (P1 or P4), PGM (P2 or 
P5), and PPM (P3 or P6). The loaded picture will be transformed to a 
picture with 256 gray-scale values. In order to display all 256 gray-
scale values a monitor setting of minimum 16 Mio. colors (24bit) is 
required. 

 
Figure 7: Image window of the SLM software 
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It is also possible to open an image by copying it to the clipboard with 
another application and inserting it into the application with the key 
combination CTRL-V. 
 

1.3.2 Image window functions 

The image window has a small toolbar with the following buttons: 
 

 ‘Zoom In’ Button 
Pushing this button will perform a fast ‘zoom in’ operation on the 
image. 
 

 ‘Zoom Out’ Button 
Pushing this button will perform a fast ‘zoom out’ operation on the 
image. 
 

 ‘Save’ Button 
Pushing this button will open a dialog in which a file name can be 
specified for saving the image in one of the supported formats (PNG 
or BMP Image, ASCII textfile matrix of integer values representing the 
grayscale values). 
 

  ‘Compute DOE’ Button 
This button will only appear if the displayed image (taking zoom 
operations into account) is no larger than 400x400 pixels.  
Pushing this button will start a computation of a Computer-generated 
hologram (CGH) phase function for the signal displayed in the image 
window. Please see section 1.4 for more information. 
The result of the computation will be displayed in a full-screen window 
where it can be manipulated as explained in section 1.4.  
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 ‘Replicate to full screen size’ Button 
Pushing this button will open a full-screen window in which the shown 
image is used as a single tile which is replicated (i.e. tessellated) until 
the whole screen is covered. The ‘basic tile’ image is centered on the 
screen. 
 

1.4 Calculating a diffractive optical element (DOE) 

To compute a DOE, the signal image size needs to be smaller than 
400x400 pixels. DOE computation for larger pictures is not supported 
by the HOLOEYE SLM software. 
Load the image as described in section 1.3. If the image is not larger 
than the supported size pixels the ‘Compute DOE’ Button will appear 
with the option to calculate a diffractive optical element (DOE) for this 
image. 
Press this button to start the Iterative Fourier Transformation Algorithm 
(IFTA). Note that the process of computing may take a short while, 
depending strongly on the signal picture size. The dialog shown in 
Figure 8 displays the progress, but also permits interruption of the 
ongoing computation. 
 

 
Figure 8: Progress of the DOE computation 

 
When the process is finished, two windows will appear. The first 
window will display the DOE phase function in full-screen size. The 
basic tile of that window has a size of the smallest power of 2 being 
larger than the image size (e.g. 512 x 512). The second window will 
show the calculated intensity of the diffraction pattern, which looks 
quite similar to the original image, provided the DOE calculation has 
properly converged. 
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1.5 Full-Screen window functions 

This full-screen image will display a task-bar immediately after its 
appearance. This taskbar will disappear if the SLM is used in ‘display 
clone mode’ and is shown in full-screen, but get visible again as soon 
as the mouse cursor is moved towards the right edge of the window. 
 

1.5.1 Main Toolbar of the full-screen window 

The functions accessibly by the taskbar buttons offer the possibility to 
manipulate the replicated ‘basic tile’ image by superposition of phase 
functions that represent optical elements (lens, prisms) or higher-order 
wavefront components, and by changing its grayscale values. 
 

 
 

Figure 9: Lower right corner of a full-screen window displaying a phase map and the 
main toolbar 

 
Some of the functions can be activated not only by pressing the 
buttons, but also by a key combination (‘hotkey’). 
 

1.5.2 Wavefront components for superposition 

The superposition of optical functions is done by adjusting sliders or 
entering integer values into the corresponding spinbox value field. In 

Adjust first order wavefront components 

Adjust third order Zernike wavefront components 

  
Adjust fourth order Zernike wavefront components 

Adjust grayscale settings

Save this full-screen-sized phase map

Display/Don't display this phase map on the SLM

Adjust second order wavefront components 
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the following table, we give a survey on the available superposition 
functions. 
 

Name Polynomial Slider range 
Tilt x r sin θ ±PN/2 

Tilt y r cos θ ±PN/2 

(De)focus r² ±1000 

Astigmatism 45° r²sin(2θ) ±400 

Astigmatism 0° r²cos(2θ) ±400 

Trifoil X r
3
sin(3θ) ±100 

Trifoil Y r
3
cos(3θ) ±100 

Coma (3
rd

 order) X (3r²-2r)sin θ ±100 

Coma (3
rd

 order) Y (3r²-2r)cos θ ±100 

Spherical abberation 6r
4
-6r

2
+1 ±100 

Astigmatism 2
nd

 45° (4r
4
-3r

2
)sin (2θ) ±100 

Astigmatism 2
nd

 0° (4r
4
-3r

2
)cos (2θ) ±100 

Quadrafoil X r
4
sin(4θ) ±100 

Quadrafoil Y r
4
cos(4θ) ±100 

 
The Zernike radius for these polynomials is taken as 
rZ = min(pixelnumber_X,pixelnumber_Y)/2-0.5, so that the full 
Zernike diameter can always be displayed on the SLM. 
For Tilt x and Tilt y, the range the software permits is chosen so that at 
the maximum values the phase switches between zero and π for the 
neighboring pixels, in order to maximize the available steering range. 
For the (de)focus term, the maximum phase range is chosen so that 
the Moiree effects due to oversampling typically do not get dominant. 
The slider range is larger because thereby a fine focus adjustment can 
be obtained.   
For all other Zernike wavefront components, the value is chosen so 
that at maximum slider positions, the wavefront amplitude obtained 
from the Zernike polynomial is multiplied by the slider value divided by 
100. That means, the 1

st
 order astigmatism terms have 4-fold wave 

amplitude compared to the remaining optional wavefront components. 
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1.5.3 Superposition of a first order phase function 

 ‘Adjust tip/tilt wavefront components’ Button   
Pushing this button will give access to the buttons that permit 
superposition with a linear phase function, which is equivalent to tip 
and tilt wavefront components. 

 
‘Superimpose prism in X direction’ Button  
 
Pushing this button will superimpose the replicated ‘basic tile’ 

image with a grayscale signal that resembles the optical phase 
function of a prism in X direction. This means that all diffraction angles 
created by the signal on the LC Display are changed when such 
function is superimposed. The corresponding angle is shown in the 
title of the window. 
The strength of the optical prism function can be changed by adjusting 
the value given on the task bar, by moving the slider, or by directly 
entering a value.  

 
‘Superimpose prism in Y direction’ Button  
 
Similarly, pushing this button will superimpose the replicated 

‘basic tile’ image with a grayscale signal that resembles the optical 
phase function of a prism in Y direction.  
 

  ‘Go back to main toolbar’ Button  
Pushing this button will simply hide all buttons related the 
superposition with first order phase functions, and make the main 
toolbar visible again. 
 

1.5.4 Superposition of a second order phase function 

 ‘Adjust defocus and astigmatism’ Button  
Pushing this button will give access to the buttons that permit 
superposition with a second order phase function, which is equivalent 
to defocus and astigmatism wavefront components. 
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 ‘Superimpose lens’ Button  
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function of a lens. This means 
that the focal plane of the light source incident on the LC Display is 
changed when such function is superimposed. The corresponding 
focal length will be displayed in the title bar of the window. 
The focussing/defocussing strength of the optical lens function can be 
changed by adjusting the value given on the task bar by moving the 
slider or by directly entering a value. 
 
The resulting focal length for a given slider value � can be calculated 
by 

� �
1000

�
∙
1

��
∙
	
�	
�

�

4	λ
	, 

with the wavelength �, the Zernike radius 
� (see above), and the pixel 
size 
. The device specific power limit factor (��) of the defocus is 

given in Table 1 for specific HOLOEYE devices. 
 

SLM device: Limit factor ��: 

PLUTO 182.1555 

LETO 182.1555 

LC-R 1080 216.2630 

LC-R 720 134.9122 

LC-2012 154.2285 

GAEA 364.4055 

Table 1: Limit factor �� for HOLOEYE devices. 

 
 

  ‘Superimpose 1
st

 order astigmatism phase’ Buttons 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing first-
order astigmatic aberration of a wavefront. The coefficient of that 
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superimposed wavefront can be changed by adjusting the value given 
on the task bar by moving the slider or by directly entering a value. 
 

  ‘Go back to main toolbar’ Button  
Pushing this button will simply hide the buttons related the 
superposition with second order phase functions, and make the main 
toolbar visible again. 
 

1.5.5 Superposition of a third order Zernike phase 
function 

  ‘Adjust Zernicke third-order wavefronts’ Button 
Pushing this button will give access to the buttons that permit 
superposition of phase functions that represent third order Zernike 
wavefront components. 
 

  ‘Superimpose coma wavefront x/y’ Buttons 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing comatic 
aberration with respect to the x or y direction. The amplitude of that 
superimposed wavefront can be changed by adjusting the value given 
on the task bar by moving the slider or by directly entering a value. 
 

   ‘Superimpose trefoil wavefront x/y’ Buttons 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing trefoil 
aberration with respect to the x or y direction. The amplitude of that 
superimposed wavefront can be changed by adjusting the value given 
on the task bar by moving the slider or by directly entering a value. 
 

  ‘Go back to main toolbar’ Button  
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Pushing this button will simply hide the buttons related to the 
superposition with third order Zernike phase functions, and make the 
main toolbar visible again. 
 

1.5.6 Superposition of a fourth order Zernike phase 
function 

 ‘Adjust Zernike fourth-order wavefronts’ Button 
Pushing this button will give access to the buttons that permit 
superposition of phase functions that represent third order Zernike 
wavefront components. 
 

   ‘Superimpose 2
nd

 order astigmatism phase’ Buttons 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing second-
order astigmatic aberration of a wavefront. The coefficient of that 
superimposed wavefront can be changed by adjusting the value given 
on the task bar by moving the slider or by directly entering a value. 
 
 
 

 ‘Adjust spherical abberration’ Button 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing first-
order spherical aberration of a wavefront. The coefficient of that 
superimposed wavefront can be changed by adjusting the value given 
on the task bar by moving the slider or by directly entering a value. 
 

  ‘Superimpose qudrafoil wavefront x/y’ Buttons 
This button will superimpose the displayed image with a XY grayscale 
signal that resembles the optical phase function representing 
quadrafoil aberration with respect to the x or y direction. The amplitude 
of that superimposed wavefront can be changed by adjusting the 
value given on the task bar by moving the slider or by directly entering 
a value. 
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  ‘Go back to main toolbar’ Button  
Pushing this button will simply hide the buttons related to the 
superposition with fourth order Zernike phase functions, and make the 
main toolbar visible again. 
 

1.5.7  Modification of displayed grayscale values (Gamma 
correction) 

 ‘Adjust graylevel settings’ Button 
Pushing this button will show the buttons related to the modification of 
displayed grayscale values, and make the main toolbar reappear. 
 

 ‘Cycling of graylevel values’ Button 
This button will add a constant graylevel offset value to the displayed 
image. If the resulting value is larger than 255, an additional offset of -
255 will be applied. The amplitude of that graylevel offset can be 
changed by adjusting the value given on the task bar by moving the 
slider, or by directly entering a value. 
Adding such constant graylevel offset is equivalent to adding a 
constant phase value (or ‘piston’ wavefront component). 
 

 ‘Adjust Gamma curve’ Button (Hotkey: CTRL+G) 
Pushing this button will permit a simultaneous change of all grayscale 
values by moving the slider or by directly entering a value. The 
gamma curve is linear if the entered value is 0, and can be changed to 
concave and convex nonlinear curves by entering positive and 
negative values, respectively. 
Note that if the ‘basic tile’ image is binary, this button will be 
accessible only if a wavefront function is superimposed to the full-
screen image. (Not that after such Gamma curve adjustment has been 
done, the button will even remain visible after setting the coefficients 
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of all wavefront components back to zero, until the Gamma correction 
itself has been set back to zero, too). 
 

 ‘Invert displayed bitmap’ Button (Hotkey: CTRL+I) 
This toggle button will invert the grayscale value of the displayed full-
screen image. This includes any superimposed lens and or prism 
functions. This inversion can be reversed simply by clicking the button 
again, which will cause the button to be no longer toggled.  
 

 ‘Adjust Graylevel 1’ Button  
This button will only be accessible if the ‘basic tile’ image is binary, i.e. 
it consists of two different graylevel values only.  
Pushing this button will than permit a change of one of the two 
grayscale values by moving the slider or by directly entering a value. 
 

 ‘Adjust Graylevel 2’ Button 
This button will only be accessible if the ‘basic tile’ image is binary, i.e. 
it consists of two different graylevel values only.  
Pushing this button will than permit a change of the second of the two 
grayscale values by moving the slider or by directly entering a value. 
 

  ‘Go back to main toolbar’ Button  
Pushing this button will simply hide the buttons related to the 
modification of displayed grayscale values, and make the main toolbar 
visible again. 
 

1.5.8 Displaying the full-screen image on the SLM ‘screen’ 

 ‘Connect to SLM’ Button – Disconnected state  
This button is only visible if the software is operated in the ‘extended 
desktop support mode’ (see section 1.2 for details how to achieve 
this). Toggling this button will change the button from a read to a 
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green traffic light button, and the displayed bitmap of the full-screen 
window will be displayed as a frameless window on the SLM.  
Obviously, only one full-screen image can be displayed on the SLM at 
a time. Therefore, if another full-screen window is already ‘connected’ 
to the SLM, toggling the ‘Connect to SLM’ button will automatically 
‘disconnect’ the other window.  
 

 ‘Connect to SLM’ Button – Connected state  
This button is only visible if the software is operated in the ‘extended 
desktop support mode’ (see section 1.2 for details how to achieve this) 
and the button has been toggled before. In this case the ‘bitmap 
content’ of the window is currently displayed at the connected SLM. 
Toggling this button will change the button to a red traffic light button, 
and the SLM screen will be erased and reveal whatever is displayed 
underneath (other windows or the desktop background).  
Note that also the ‘external window menu’ (see section 1.9.2) can be 
useful for selecting the full-screen image to display on the SLM. 
 

1.5.9 Saving the displayed full-screen image 

 ‘Save’ Button (Hotkey: CTRL+S) 
Pushing this button will open a dialog in which a file name can be 
specified for saving the full-screen image in one of the supported 
formats (PNG or BMP image, or ASCII text matrix of integer values 
representing the grayscale values).  
The image will be saved as displayed, i.e. including effects by 
superposition of optical functions etc. 
 

1.5.10 Copying the displayed image to the clipboard 

By pressing Ctrl+C when a full-screen image is active, the full-
resolution image is copied to the ‘clipboard’ of the Microsoft 
Windows™ operating system. 
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Figure 10: Message appears after copy operation 

 

1.6 Creating essential optical functions 

All optical functions from the menu point Essential Optical Functions 
appear in a new window after input of the required parameters. 
Depending on the optical function, binary or multilevel, the task bar of 
the full-screen window will be slightly different (compare section 1.5). 
 

 
Figure 11: Menu entries for optical functions 

 

1.6.1 Blank Screen  

With this function you can create a homogeneous graylevel screen. 
You will be asked to enter the desired graylevel. 
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1.6.2 Horizontally Divided Screen  

With this function you will create a horizontally divided screen, 
consisting of two homogeneous graylevel partial screens. 
  

1.6.3 Vertically Divided Screen  

With this function you will create a vertically divided screen, consisting 
of two homogeneous graylevel partial screens. 
  

1.6.4 Random Bitmap  

With this function you will create a random pixel distribution using 256 
graylevels. This function can be used to realize the optical function of 
a random phase plate. 
 

1.6.5 Random Binary Bitmap  

With this function you will create a random pixel distribution using only 
two grayscale values. This function can be used to realize the optical 
function of a random binary phase plate. 
 

1.6.6 Aperture Functions   

1.6.6.1 Rectangular Aperture 

Use this function to create a rectangular aperture. The size of the 
aperture can be defined by specifying the aperture width and aperture 
height. With the sliders on the taskbar one can change the gray levels 
of the background and of the aperture.  
 

1.6.6.2 Circular Aperture 

Use this function to create a circular aperture. The radius of the 
aperture can be defined by specifying a numbers of pixels. With the 
sliders on the taskbar one can change the graylevels of the 
background and of the aperture.  
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1.6.6.3 Single Slit and Double Slit  

To create a single slit choose the point ‘Show Single Slit’ from the 
menu point Aperture Functions. The slit width can be defined by the 
number of pixels in the dialog window. 
To create a double slit choose the point ‘Show Double Slit’ from the 
menu point Aperture Functions. Moreover the slit distance can also be 
defined. This refers to the distance between both slits. 

1.6.7 Fresnel Zone Lenses 

1.6.7.1 Binary Fresnel Zone Lens 

Use this function to create a Binary Fresnel Zone Lens graylevel 
image representation. In the dialog field the lens function can be 
characterized by the radius of the smallest ring, which is defined by a 
number of pixels ��,���. The focal length of the lens is given by 

� �
	��,���	
�

�

λ
 

where � is the wavelength of the laser which was entered when 
starting the software. 

1.6.7.2 Fresnel Zone Lens 

Use this function to create a 256-level Fresnel Zone Lens grayscale 
image representation. In the dialog field the lens function can be 
characterized by the radius of the smallest ring, which is defined by a 
number of pixels. The focal length of the lens is given by 

� �
	��,���	
�

�

2λ
 

where � is the wavelength of the laser which was entered when 
starting the software. 
It can be specified whether the image representing the lens should be 
positive or negative. 

1.6.7.3 Cylindrical Fresnel Zone Lens 

Use this function to create a 256-graylevel image representation of a 
Cylindrical Fresnel Zone Lens. In the dialog field the lens function can 
be characterized by the width of the central zone, which is defined by 
a number of pixels ��,���. The focal length of the cylindrical lens is 

given by 
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� �
	��,���	
�

�

8λ
 

where � is the wavelength of the laser which was entered when 
starting the software. 
The angular orientation of the cylindrical lens can be entered in 
degrees (integer values only). 

1.6.8 Binary Axicon 

Use this function to create a Binary Axicon graylevel image 
representation. In the dialog field the lens function can be 
characterized by the radius of the smallest ring, which is defined by a 
number of pixels. 

1.6.9 Axicon 

Use this function to create a 256-level Axicon grayscale image 
representation. In the dialog field the axicon function can be 
characterized by the radius of the smallest ring, which is defined by a 
number of pixels. It can be specified whether the image representing 
the lens should be positive or negative. 

1.6.10 Vortex Phase 

Use this function to create a 256-graylevel image representation of a 
vortex phase (often also referred to as ‘helical phase’ or ‘spiral 
phase’). In the dialog field the radius a central zone with constant 
phase can be specified as a number of pixels. The order of the vertex 
can be entered also as an integer value, for production of higher-order 
Laguerre-Gaussian beams. 

Note that the angular orientation of the line where the phase changes 

from 0 to 2π can be modified by superposition of the displayed phase 
with a constant phase value (see section 1.5.7, ‘Cycling of graylevel 
values’). 

1.6.11 Concentric ring segments  

Use this function to create binary images consisting of concentric ring 
segments. In the dialog field the image function can be characterized 
by the radius of the smallest ring, which is defined by a number of 
pixels, and the desired number of segments, which can be varied from 
two to 20 (even numbers only). 
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1.6.12 Binary beam-splitter gratings 

1.6.12.1 Linear Gratings and Crossed Linear gratings 

Choose from the menu Binary beam-splitter gratings the item ‘Show 
Binary Linear Grating’ to create a grating. The grating period can be 
defined by the number of pixel. By selecting the boxes the grating 
direction can be chosen to horizontal or vertical. Check both boxes to 
overlap a horizontal with a vertical grating and obtain a crossed 
grating. 
 

1.6.12.2 Exemplary binary beam-splitter designs 

Choose from the menu Exemplary binary beam-splitter designs one of 
the menu items 

• Show Binary Linear 1-to-5 Linear Beamsplitter Grating 
(Grating period 26 Pixels)  

• Show Binary 1-to-(2x2) Separable Array Beamsplitter Grating 
(Grating period 18x18 Pixels) 

• Show Binary Array 1-to-(5x5) Separable Array Beamsplitter 
Grating (Grating period 26x26 Pixels) 

• Show Binary Array 1-to-(5x5) Non-separable Array 
Beamsplitter Grating (Grating period 26x26 Pixels) 

to obtain a full-screen window with one of the mentioned diffractive 
elements. 
The basic tiles of these gratings are fixed and usable as examples for 
separable and non-separable binary DOEs. 
 

1.6.13 Sinusoidal Grating 

Choose from the menu point Essential Optical Functions ‘Show 
Sinusoidal Grating’ to create a sinusoidal grating. The size of the 
grating period can be specified by the number of pixels. 
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1.6.14 Blazed Grating 

Choose from the menu point Essential Optical Functions ‘Show 
Blazed Grating’ in order to create a blazed grating. The size of the 
grating period can be specified by the number of pixels. 
 
 

1.7 Calculating a beam-shaping phase function for 
Gaussian Input beams 

For incident laser beams with Gaussian beam profile, the SLM can 
modify that beam shape into other intensity profiles by utilization of an 
appropriate phase function. The HOLOEYE SLM software provides 
phase functions for two special cases of such transformation: 
conversion into spherical and rectangular flat-top profiles. 

1.7.1 Transformation of a Gaussian beam to a circular 
‘flat-top’ beam 

Select ‘Transformation of Gaussian to circular Top-Hat beam’ from the 
‘Beam Shaping’ menu. The required parameters are the beam 
diameters (1/e²) in the plane of the SLM, and the parameters of the 
desired output beam. The parameter ‘Order of Super-Gaussian’ will 
influence the slope steepness of the obtained profile. Higher Super-
Gaussian Modes have a higher slope steepness. 

 
Figure 12: Parameters for computation of a beam-shaping phase  

 
A laser beam can only be focused to a certain diameter depending on 
beam diameter, lens focal length and wavelength, and beam shaping 
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phases cannot enable focusing below such limit. Therefore, if the 
target beam diameter is too small, the software will issue a message 
and suggest a more realistic target value. (The software currently does 
not check if the desired target beam size may be too large.) 
 

 
Figure 13: Warning message shown if target beam diameter is too small  

 
The beam-shaping setup may incorporate a Fourier-lens and in this 
case the working distance is equal to its focal length, as the target 
plane is identical to the back focal plane. If no lens is used (and the 
corresponding checkbox is unchecked in the dialog shown above), the 
lens phase will just be superimposed to the beam-shaping phase. 
 

1.7.2 Transformation of a Gaussian beam to a rectangular 
‘flat-top’ beam 

Select ‘Transformation of Gaussian to rectangular Top-Hat beam’ from 
the ‘Beam Shaping’ menu. The required parameters are the beam 
diameters (1/e²) in x and y direction in the plane of the SLM, and the 
size in x and y direction of the desired output beam. The parameter 
‘Order of Super-Gaussian’ will influence the slope steepness of the 
obtained profile. Higher Super-Gaussian Modes have a higher slope 
steepness. 
If the target beam dimension is too small to be feasible in either 
direction, the software will suggest a suitable beam size, maintaining 
the aspect ratio of the originally desired target beam. 
 

1.8 Superposition with an additional phase map 

The HOLOEYE SLM software permits a superposition of the phase 
functions displayed in its full-screen windows with an additional phase 
map. This can be utilized to compensate for aberrations of the optical 
system or that of the SLM. This phase map has to be available in an 
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image file format (like .bmp, .png) where the grayscale values 0..255 
represent phase values of 0 .. 2π. The phase value will be added to 
the already displayed phase function. For all pixels with resulting 
grayscale values of larger than 255, the software will subtract 255 in 
order to stay within the permitted range of 0..255. 
Only one background compensation can be loaded into the software 
at a time.  
 

1.8.1 Loading  

Select ‘Load Background Compensation Phase Map from file’ from the 
‘File’ menu. Note that all already opened full screen windows will be 
affected. Also, any newly opened full screen windows will be subject to 
superposition with this background map. The superposition will be 
indicated in the caption of the full-screen control window by the file 
name from which it was loaded. 

1.8.2 Unloading 

Select ‘Unload Background Compensation Phase Map from file’ from 
the ‘File’ menu. Note that all open full screen windows will be affected 
from the operation, i.e. after completion the background compensation 
phase map will not be applied to any full-screen window. 
 

1.9 The ‘Window’ Menu 

1.9.1 Windows inside the main window 

The Menu ‘Windows’ contains the usual options for tiling, cascading 
and closing windows that are opened inside the main window. 
Selecting an entry in that window list will simply make that window 
active. 

1.9.2 Full-screen windows outside the main window 

When full-screen windows are open outside the main window, they will 
be listed within this menu, with their index number in square brackets. 
Selecting the cursor position in front of one full-screen window will 
send the image of this full-resolution image to the screen representing 
the SLM. De-selecting an entry in this list will render the SLM screen 
blank. 
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Figure 14: Window menu with list of internal and external windows 

 
In addition, all of these windows can be closed at once via a separate 
menu point ‘Close all windows outside the main window’.  
Of course the menu item ‘Close all windows inside the main window’ 
does not affect full-screen windows outside and vice versa. 
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If you have any further questions, please get in contact with 
HOLOEYE: 

 

 
HOLOEYE Photonics AG 
Albert-Einstein-Str. 14 
D-12489 Berlin 
slm@holoeye.com 
www.holoeye.com 

 
 

 
 


